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OVERVIEW

Chapter 1 - Overview

Aztec C68k/ROM is a set of programs for developing programs in the C programming lan-
guage; the resulting programs run on ROM- and/or RAM-based systems that use a Motorola
68000-family microprocessor.

The Aztec C68k/ROM is a comprehensive ROM development system including the following
features:

* The full C language, as defined by the American National Standards Institute (ANSD)
is supported.

* An extensive set of user-callable functions is provided, in both source and object form.
You will probably need to modify some of the system dependent functions. For exam-
ple, you will probably need to customize the startup routine; and if you want to use
either the standard I/O or unbuffered 1/O functions, you will need to write the unbuf-
fered 1/0 functions.

* As of version 5, the MPW shell is now supported. The Aztec UniShell has been in-
cluded with this release to facilitate old users. New users should use the MPW Shell.
Future releases will not include the Aztec UniShell.

* Modular programming is supported, allowing the components of a program to be
compiled separately, and then linked together.

* Assembly language code can either be combined in-line with C source code, or
placed in separate modules which are then linked with C modules.
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e Programs can be generated in several formats, including Motorola S-records, Intel Hex
records, and Tektronix TekHex records. ROM chips generated from these records will
contain the program'’s code and a copy of its initialized data.

e A ROM program can contain both initialized and uninitialized global and static vari-
ables. When the program starts, its initialized variables in RAM will be automatically
set from the copy in ROM, and its uninitialized variables will be cleared.

The functions provided with this package are ANSI compatible and are compatible with Aztec
C packages provided for other systems. Thus, once you have customized the functions, you can

create programs that will run on ANSI-based systems or on other systems supported by Aztec C
with little or no change.
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Components

Aztec C68k/ROM contains the following components:
* MPW, shell produced and supported by Apple
e ¢68, the Aztec compiler;
* as68, the Aztec assembler;
¢ In68, the Aztec linker;
¢ 1b68, the object module librarian;
* z, a text editor that is compatible with the UNIX vi editor;
* Source and object code for the library functions;

* make, grep, and diff, utilities that are compatible with the UNIX programs of the
‘same name.

* Several utility programs

Overview
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Documentation

The Aztec C68k/ROM chapters included in this manual are:
e MPW Shell, describes how to install and use the MPW shell;
¢ ROM Tutorial describes how to get started with Aztec C68k/ROM: it gives an over-
view of the process for turning a C source program into Motorola S-records and Intel

hex records;

- e Compiler, Assembler, and Linker present detailed information on using the compiler,
assembler, and linker;

e Utilities describes the utility programs that are provided with Aztec C68k/ROM,;
e Z Editor describes the Z text editor and all of its features;

e Library Customization describes (1) modifications you can make to the provided li-
brary source; and (2) the creation of object module libraries from the provided source;

¢ Library Overview presents an overview of the functions provided with Aztec C;

e Library Functions describes the system-independent functions provided with Aztec
C68k/ROM;

¢ Technical Information discusses miscellaneous topics, including C-callable assembly
language functions, and C language interrupt handlers;

¢ Error Messages lists and describes the error messages that are generated;

¢ Technical Support details the guidelines to be followed when in need of technical as-
sistance.

| Overview
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Wide Range of Choices

Aztec C host and target packages are available for the following combinations:

Host
PC-DOS/MS-DOS

PC-DOS/MS-DOS
PC-DOS/MS-DOS
PC-DOS/MS-DOS
Macintosh

CP/M-80

Target
8086/80186/80286/8087 /80287

6502/65C02
68000/68010/68020/68881 /68851
8080/8085/280/64180/2180
68000/68010/68020/68881 /68851
8080/2Z80

For information on these Aztec C Cross Development Systems, as well as the numerous Aztec C
Native Development Systems that are available, contact the Manx Software Systems Sales De-
partment at 1-800-221-0440 (International call 908-542-2121.)
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How to Proceed

Now that you have Aztec C, the first thing you are going to do is...
...read the manual?

If you are like most users, probably not. The Manx manuals are a very thorough and very im-
portant part of your Aztec C package, but we recognize that you may be anxious to put Aztec C
to work as soon as you can. To some users, that means “skimming” the important parts and get-
ting to the rest later.

In light of this, we would like to offer a bit of advice. The list below, for both new and experi-
enced users, shows how we suggest you proceed. This may help you off to a quicker start.

Step 1: Read the README file (on disk).

Step 2: Install your Aztec C disks. Installation instructions have been included in the
README file and MPW Shell chapter.

Step 3: Read the remainder of the MPW Shell chapter to familiarize yourself with the
MPW Shell and the new Project Manager.

Step 3: Read the Tutorial chapter which will take you through a step by step process
of how to produce a ROMable application.

Step 4: Read through the Library Customization Chapter which discusses how to im-
plement the low-level functions necessary in order to use any additional func-
tions documented in Library Functions chapter

Step 5: Refer to Compiler and Linker chapters for correct option usage.

Step 6: Refer to the Utilities chapter for information on the format conversion utili-
ties: Motorola S-rec format (srec68), Intel Hex format (hex68), and Extended
Tek-hex format (tekhex68)

Once you have followed the above steps, you should have a better understanding of your Aztec
C Cross Development System and its capabilities. You should look through the rest of the docu-
mentation, paying particular attention to the Compiler, Assembler, and Linker chapters.

Other chapters that have been affected by the ANSI standard and should be reviewed are Utili-
ties, Technical Information, and Error Messages.

This manual is straightforward and very thorough, and is designed to be a helpful aid to your
programming efforts.

| Overview
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About This User Guide

Throughout this manual, we use the following conventions:

prototype

input

DEFINITION

{choicel!l choice?2)

placeholders

output

<key>

Ax

[optional]

is used in "prototype statements" to indicate how data should be en-
tered by the user

to indicate data entered by the user (e.g., commands, options, and
functions)

small uppercase bold is used on terms that may be new to the user;
most will probably include explanation or definition of term

braces and a vertical bar mean that you have a choice between two
or more items

information that must be supplied by the user; for example, file-
name, range, identifier, etc.

to show text that is generated by the computer

is used in examples to indicate the actual key to press, i.e. <En-
ter>, <ESC>,etc.

is used to indicate that you should hold down the control key while
typing the specified letter

to show optional information

Overview






MPW Sur

Chapter 2 - MPW Sheli

Aztec C and MPW truly provide “the best of both worlds”: the sophisticated MPW Shell, the
new Manx Project Manager, combined with the superior Aztec compiler, assembler, and linker.

Please read this entire chapter before proceeding with Aztec C68k ROM. This chapter will dis-
cuss the following topics:

e Introduction to MPW

¢ Installation procedure

* Overview of the new project manager, Manx Project Manager
* MPW WorkSheet

¢ Executing commands from the WorkSheet

 MPW Help facilities

e MPW Tools
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MPW Overview

The MPW Shell was developed by Apple Computer to handle the largest and most complex of
programming projects. Note that Aztec C68k + MPW does not include a native Macintosh com-
piler, assembler, or linker. Instead, the MPW Shell works with the Aztec C68k compiler, assem-
bler, and linker to provide a sophisticated development environment for ROM-based systems.

The MPW Shell includes a Macintosh-style text editor and a UNIX-style line-oriented command
interpreter. Used with Aztec C, the MPW Shell supports external Aztec and MPW tools and ap-
plications from within the Shell, including the Aztec C68k compiler and other utilities.

Manx provides you with two different routes into Apple’s MPW. First, there is the Manx Project
Manager. This is an additional menu item in MPW installed by Manx which allows you to edit,
compile, link and run programs entirely by menu. It does away with the initial need of learning
about MPW commands and compiler/linker options so you can begin working immediately
and productively with Aztec C.

Second, if you are used to developing with a command-line based operating system or a
“make” utility, you can also do that from within the MPW Shell. The compiler and assembler
can be invoked directly via the C68 script. There are two versions of make: the Aztec version,
which is patterned after Unix, and the Apple MPW version. The Aztec version should be used
to build the libraries, since their makefiles have been written for it.

Additional MPW Books

If you want to acquire a complete understanding of the MPW Shell and its use, you may pur-
chase Apple’s MPW: Macintosh Programmer’s Workshop Manual or Mark Andrews’s Programmer’s
Guide to MPW (Addison-Wesley, Reading, MA). For ordering information, call the Manx Sales
Department at 1-800-221-0440. (International call 908-542-2121.) For a listing of other useful
books you should consider, see the Bibliography.

Where To Go From Here

To get started quickly, follow these procedures in order.
1. Follow the installation procedure outlined in the next section.

2. Following the installation, you should read the remainder of this chapter to become fa-
miliar with the Project Manager and the MPW Shell. This is especially important if you
have never used the MPW Shell before.

3. After finishing this chapter, you will be ready to begin using Aztec C68k to build
your own program.

4. If you decide to do your development outside the Project Manager, using either a
makefile or the command line directly, you'll need to refer to the Compiler and Linker
chapters for correct option usage.
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5. See the ROM Tutorial chapter for information on transferring your program to a
ROM system.
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Installing Aztec C68k ROM

Installation is relatively straightforward with the new Aztec Install program. It copies over the
necessary files for the Aztec package and the MPW Shell on to your hard disk. Before you begin
using it though, be sure to read the README file on the first disk. Any final notes about instal-
lation or the Aztec package in general will be found there.

It is impossible to skip the Aztec Install program and selectively copy over files. The files are
stored on the disk in compressed form, and the Aztec Install program is used to uncompress
them as they are copied over. There is an Aztec LZH program which can be used in an emer-
gency to decompress individual files on the disks.

The Aztec Install program is found on the first disk of your package. Be sure to copy the pro-
gram to your hard disk and launch it from there. When requested, insert your distribution
disks. A folder called MPW will be created on your hard disk if there is not one there already.
By default, this will be in the root directory of the specified hard disk, unless the hard disk
name is followed by a directory name. The program will proceed to copy all the files from your
floppy disks and place them in the appropriate folders on your hard disk.

Note to owners of Manx’s Aztec C Macintosh compiler: the Macintosh native compiler is in-
stalled in a folder called “Aztec,” which is within the “MPW” folder. The Aztec C68k ROM com-
piler is installed in a folder called “C68K ROM” within the “MPW” folder.

Files Supplied

Apple’s basic MPW package is included on the diskettes shipped to you. Only the files neces-
sary to use Aztec C68K under MPW are installed. Tools for native Mac development are not.

The following is a brief description of the principal Aztec files included in your package:
The Tools folder

The main programs:

cc68 Aztec C compiler
as68 Aztec assembler
In68 Aztec linker
Additional tools:

obdé8 object code dumper
hex68 Intel hex code generator
srec68 Motorola S-record generator
tekhex Tektronix extended tekhex generator
1b68 object file librarian
ord68 : orders object modules for a library
cnmé8 examines object files

Clncludes folder

Header files in the CIncludes folder contain prototype definitions, and declarations to
support the C language as defined by the ANSI standard. The only ones you have to in-
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clude in your program are the ones required by the library functions you use, specified
by the documentation.

The CLibraries folder:

A set of libraries has been built with the default register options for testing, however,
you will probably want to generate your own, using register options that fit your appli-

cations.
clib main C library
m.lib IEEE floating point library
m8.1lib 68881 math coprocessor library
The CObjects folder:
Default startup code. You will probably want to modify the startup code to fit your ap-
plication.

After the Manx Install program has been run, you should find the MPW folder with the
following folder structure inside it:

MPW

A

Tools C68k ROM Examples Scripts
Scripts Clncludes Projects CLibraries CObjects libsource Tools

Figure 2 - 1 -— MPW Folder Structure

MPW Shell
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Verification

To verify that your Aztec C68k MPW package is properly installed, enter the MPW shell by dou-
ble clicking on its icon in the MPW folder. From in the MPW shell enter the following;:

C68 <Enter>

Be sure to press the <enter> key on the keypad, NOT the <return> key. An alternative is to hold
down the <CMD> key and press <return>. A banner similar to this should appear in the Work-
sheet window:

Aztec C68k/ROM 5.2
Copyright 1992 by Manx Software Systems, Inc.
No input file was specified!

If You Have a Problem

If you have followed the above instructions and are still having difficulty, then you should:

1. Reinstall Your Program

Try the Install program again. Was there a fail message you missed? Be sure there is enough
space on your hard disk.

2. Check Your Disks

Aztec C includes a CHECK program and Checklist to help you determine whether your disk
contents are complete and accurate, or if your disks have been corrupted.

Aztec C uses the CHECK program to identify each file by assigning a unique number to it. You
use the Checklist file to compare the files and make sure that we sent you all the files to which
you are entitled. After you have run the CHECK program, report any discrepancies to Technical

Support.

You can make this comparison in either of two ways.

A. Turn on your machine and enter the Finder. To verify that all files have been in-
cluded:

1. Insert the first disk into your disk drive. Click once on the Checklist icon and se-
lect Print from the Finder File menu. This will give you the Checklist file in hard-
copy format.

2. Display the contents of the first disk on the screen. To do this, double click on
each folder, then select By Name from the Finder View menu.

3. Compare the list on the screen with your hardcopy list.

B. Turn on your machine and enter the Finder. To verify that all files have been included
AND that nothing has been corrupted:
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1. Insert the first disk into your disk drive. Click once on the Checklist icon and se-
lect Print from the Finder File menu. This will give you the Checklist file in hard-
copy format.

2. Run the CHECK program for each file on the disk, as follows:
a. Copy the Check program to your hard disk (found on the first disk which
came with your original Aztec C package).Double click on the Check icon to
run it. A dialogue window will appear on your screen; this window is similar
to the standard Macintosh File Requester.
b. Insert your first MPW disk into the disk drive.
c. Click on Do All. A CRC for each of the files will be displayed.
d. Use your hardcopy to compare the checksum numbers.
e. Click Ok to display the next file. (Do not be alarmed if some files take
longer than others to display.) Continue until all files have been checked. You
can stop at any point by clicking on CANCEL. To check an individual file,
double click on the file to be checked. Repeat this procedure for each of your
MPW disks.

f. Click on Quit to exit.

3. Call Technical Support

If your Aztec C system is still not functioning, contact Technical Support using the
guidelines found in the Technical Support chapter of your Aztec C documentation.

MPW Shell
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The Manx Project Manager

Two Managers in One

The Manx Project Manager allows you to work on a project level or a program level. The project
level can handle different types of programs made up of one or more source files. The program
level deals with compiling and linking a single-file program.

Whét the Project Manager Manages

Besides acting as an interface to MPW, the project manager takes care of organizing your directo-
ries and files. It does this by opening a new folder for each project and placing all related pro-
grams into it. The folder in which all these project folders are opened is called Projects and is
found in the C68k ROM folder. The following is a map of this organization:
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hd
37 items 59,397K indisk  17,463K available

& O O

System Folder AppleLink  HyperCard

MPLU
15 items 59,397 indisk  17,463K available
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C68KROM MPY Shell Scripts Tools
C68KROM
7 items 59,397K indisk  17,463K available

) OO O

F;ro jects Cincludes CObjects CLibraries
Projects |

1 item 59,397K indisk  17,463K available
&H i
o| [l
K2l [ [Trash

Figure 2 - 2 - ROMProject Menu Selections

The project manager also keeps track of when you last ‘built’ the current project. If you altered
any of the source files since then, it will be sure to recompile those files before linking the pro-

gram.

Finally, the project manager asks for and remembers the type of program you are building. It
uses this information to select the proper compiler, linker, and hexer options for the specified
program type. For the options used, refer to the section “Program Types” later in this chapter.
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When you click on ROMProject it offers the menu selections shown below in figure 2-3.
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Figure 2 - 3 --- ROMProgram Choices

After you choose to either start a New Project or Open a previous one, the Manx Project Man-
ager changes its name to that of the chosen project and then enables the Build and Modify
menu items. Clicking on Build will compile and link all the necessary files to produce a RO-
Mable program. If you need to add or delete files to the project, or change its type or name, use
Modify Project. The Drop Source and Add Source items in Modify Project work together in al-

lowing you to remove and add files from the project without actually deleting the files from the
disk.

When a project is opened the Manx Project Manager also adds to the project menu the names of
the .c and .a68 files in that project. Clicking on the name of a file in the menu will open that file
if it is still closed, or simply bring its window to the front if it is already opened. The No Project
item switches to the program manager. Finally, Compile lets you compile just the front most
window apart from the rest of the project.

NOTE: Source file names must have either a .c or .a68 extension to be recognized by the Manx
Project Manager. It will not accept any others.

About the Program Manager
————_“_________M—Q——QN

The Manx Project Manager is completely contained in the last menu item of MPW. As pre-
viously mentioned it is first entitled ROMProject. Figure 2-3 above shows the screen after click-

ing on it. To change to the program manager, choose No Project. The Manx Project Manager
will now be entitled <ROMPrograms>.
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When you click on the ROMProgram item you will see the choices as illustrated in Figure 2-4
below:
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ces..

Figure 2 - 4 --- ROM Program Choices

As with the project manager, the Manx Project Manager changes its name to that of the chosen
program. It then opens a window for you to begin programming. The Build item, which both
compiles and links your program, would also be enabled at this point. Clicking on the last
choice, Project, restores the former project menu.

Using the Manx Project Manager

When you click on the MPW icon and first enter MPW you are presented with a window called
the WorkSheet. For working in MPW directly this is an important window. For using the Manx
Project Manager it is not. The WorkSheet is an integral part of the MPW environment and is al-
ways present, but not used by the Manx Project Manager in any way. You can go right to the
Project menu item and click on it to begin working.

Starting a New Project involves specifying 3 things: its name, the files that are to be part of it,
and the build options. The Manx Project Manager uses the Macintosh Commando interface to
gather this information from you. With this interface you can hold down the mouse button
while pointing at an option on the screen and get information about it in the Help box. After set-
ting up your project, the Manx Project Manager opens windows for you to begin working.

At this point you will find useful the other MPW menu items besides ROM Project. Edit and
Find access some key editing and searching functions that like most Macintosh facilities are self-
explanatory and easily used. The Window menu item offers another means to pull a window to
the front and also provides a list of the currently opened windows. The left most menu item is
File. But before mentioning its use, a discussion on files in general is necessary.
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Files and Windows

Although the relationship between files and windows in MPW is fundamentally simple, it
could cause some confusion if not fully understood. A file exists on your disk. When it is
opened it is assigned a window of its own in MPW. When a window is closed that you worked
in, MPW will give you an opportunity to save it back to the file on disk. If you choose not to,
understand, you will lose all the work you have done. Also, if no work was actually done in the
window, MPW assumes there is no need to even ask you if you want to save it.

A special case of this relationship is when a new file is created. MPW opens a window for the
file but does not create the file on disk until it is first saved. This can cause some confusion
when you use New Project. The project manager will open as many windows as there were
source files specified when you first start a project with New Project. If however you work in
only one of them in that MPW session, MPW will not create the others on disk and the project
manager will forget about them. You can always use Modify Project to create new source files
later during a project so there really is no problem here. But be aware when first specifying files
in New Project that those files will be lost to the project manager that do not have anything
typed into their associated windows.

The File menu item of MPW is typically used to open and save files. With the Manx Project
Manager, file opening is completely taken care of for all .c, .h, and .a68 files. You might want to
use the File menu to save your files periodically during your work session. If you have not
saved your work by the time you exit MPW, you will be given a chance to do so as MPW closes
the windows for exiting. Because the Manx Project Manager does not handle closing and saving
files, this is something you must pay particular attention to.

Output from the Manx Project Manager

When building your project, the Manx Project Manager opens a special window called
AztecC.err. This will be updated with information as to what files are being compiled, etc. If
any errors occur, these will also be placed in this window. Compiler and Assembler errors are
written in such a way that selecting a line and hitting <enter> will result in the file being
opened and the line containing the error being highlighted. By default, the first error will be se-
lected,and executed to position you in the source at the location of the error. The AztecC.err
window is for diagnostic output and therefore would not typically need to be saved.

Program Types and Options

When the Manx Project Manager builds a program, it sets various options depending on the
type of program specified. One of three types of programs can be built, based on the hexer
used. It can be the Intel hex which uses the hex68 utility. A second choice is Motorola SRec,
which uses srec68. The third type is Tektronix Tekhex, which uses the telhex utility. In addition
to the type of program, you must specify several other options including the registers to be
used, the location of code and data, and the size of the ROM chip. These are the basic options
necessary in order to build a ROM program. If you have requirements beyond this, you will
probably have to use a makefile to build your program.

Files in the project manager are listed in alphabetical order. The primary reason this is of impor-
tant is for ordering object files for linking, In order to have your startup code linked in first, it
has to have a name that comes alphabetically before any other source file. An easy way to ac-
complish this is to start it with an underscore.
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Customization

The Project Manager attempts fo give a graphical interface for the most commonly used features
in the compiler, assembler, linker, and hexers. With this being the case, you may find a need to
use a feature not directly supported. If this is the case, you can customize your project build.

When you open a new project, the Project Manager creates a makefile using the options you
specified. The makefile created has the same name as the project with a .make extension. This
file can easily be edited to conform to your specific needs. Compiler, assembler, linker, and
hexer options can easily be modified by changing the values for CFLAGS, AFLAGS, LFLAGS,
and HFLAGS.

After customizing the makefile, remember not to select the Modify option in the Project Man-
ager. If you modify the project, the makefile will be overwritten and your customizations will
be lost.
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The MPW Worksheet

MPW comes up in a window called the WorkSheet. This window is the focal point, or home
base of the environment. You would not edit any of your programs in this window. Instead,
you would use it to issue commands and keep a storehouse of frequently used commands. Be-
cause the WorkSheet is saved automatically, you carry its contents from session to session.

From the WorkSheet you could use the mouse and menu bar to create a new file for your pro-
gram. Upon doing so you would be in another window opened for that file. The number of win-
dows you open is limited only by the amount of RAM you have. To go from one window to the
other you need to only click on a visible portion of a window, or use the Window menu item.

You execute a command in MPW by typing it in and then pressing the <enter> key - NOT the
<return> key. The <enter> key turns any line in any window into a command line. You can eas-
ily reissue a command by selecting it with the mouse and pressing <enter>.

To compile a program, type C68 and the program name. MPW will compile the file of that
name including any changes made to it but not yet saved. You invoke the linker by typing In68
and the object file name, which is the program name with a .r extension.

As far as discovering more about the commands and options while using MPW, the HELP com-
mand and the Commando interface will prove invaluable. You can type "HELP commands’ to
see a complete list of commands. You can also type "HELP <command name>" to find out about
the options offered for that command. And by just typing "HELP’ alone you will see all the
other categories of information you can get help on.

You invoke the interactive Commando interface by either following the command name with an
elipsis (OPT-;), or by holding down the <option> key while pressing the <enter> key. The op-
tions for a command are displayed in a dialog box which allows you to find out more about
each one before selecting it.
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Executing Worksheet Commands

Simple Commands

NOTE: In the following examples, <enter> designates the enter key on the numeric keypad,
which is used to signal MPW commands.

If you are not in the MPW Shell at this time, double-click on the MPW Shell icon in the MPW
folder on your hard disk to enter it.

The Files Command

One of the most common MPW commands is the Files command. From the worksheet, type:

Files <enter>

This will list all the files contained in the current directory. For more detailed information on the
files in the current directory, you can type:

Files -1 <enter>

This will display complete information about each file, including the flag attributes, file size, file
creator, creation date, file type, etc. A header at the top of the file list will describe each field.
Note that many files may have any one of a variety of extensions. These extensions are there for
your convenience, to indicate file types by name. See Figure 2-5 for a complete listing of the file
extensions that are common in the Aztec C system under the MPW Shell.

Extension File Contents

.c ¢ source file

.0 object or relative file

Jh include or header file

.a68 68000 assembly language source file
Jib library

Sym symbol table for an executable file
Jst assembler listing

.dbg symbolic debugger

no extension linker generated command file

Figure 2 - 5 -—~File Extensions under MPW Shell
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You can also pass arguments to the Files commands. For example, you can tell Files the name of
a folder whose contents you wish to examine. To see the contents of the tools folder under the
MPW folder, type:

Files tools <enter>

The contents of any directory can be listed at any time by using the files command with the ap-
propriate path.

Wild cards can also be used with almost every command that allows a file specification. (One
notable exception to this is the Rename command.)

A wild card is a pattern that can match a group of files. For example, if you use the Files com-
mand and type:

Files ?* . c <enter>

all the files that end with a .c extension will be listed. For a complete list of filename generation
wild cards, use the Help selections command.

The Directory Command

The MPW Shell uses the concept of a current directory, which is analogous to the active win-
dow under the Finder. To see the name of your current directory in the MPW Shell, type the
command:

Directory <enter>

The full path name of your current directory, including volume name, will be displayed. You
can also change the MPW Shell’s notion of the current directory. If you type:

Directory "hd:" (substitute your hard disk name for hd)
the current directory will become the root directory of your hard disk.
Type:

Directory <enter>
to confirm this.

Note that you need not always use a full pathname to move within the file system. To reach a
folder beneath your current directory, the command:

Directory FolderName <enter>
will place you there.

The MPW Shell also supports the concept of parent directories. If your current directory was
hd:MPW:Tools, and you wished to reach the parent of this, which is hd :MPW, you would type:

Directory :: <enter>
As a general rule, if a colon is the first character encountered in a pathname, the colon is consid-

ered to be the current directory. If any colons immediately follow the first colon, then each colon
will move you up one level in your file system (toward the root directory). Since the previous
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command had two semicolons, you moved up just to the parent directory. To move two levels
up from hd:MPW:Tools to the root directory of hd:, or to the grand-parent directory, type:

Directory ::: <enter>

Try combining the Files and Directory commands now to practice moving around through your
file system.

The Volumes Command

A command related to Directory is Volumes. The Volumes command displays a list of all of the
volumes currently mounted in your system. Therefore, typing:

Volumes <enter>

would result in an output similar to this:

hd:
sys:

The exact names that will be displayed will depend on your system.

The NewFolder Command

The NewFolder command is used for making a new folder, or directory, exactly as the New-
Folder Menu item under the Finder does. To create a new directory under your current direc-
tory, simply enter NewFolder followed by the name for the new directory. For example, to
create a directory named Src under the current directory, you can type:

NewFolder Src <enter>

The Delete Command

Files can be easily moved around or deleted under MPW using the built in command Delete.

Warning: You can potentially delete your ENTIRE hard disk with a single Delete command, so
use it with CAUTION!!!

The command

Delete hello.c <enter>

will delete the file named hello.c in t<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>